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Resumen— EI propdosite del siguiente trabajo es
aprender la metodologia por la cual a partir de un
archivo escrito en codigo VHDL puede ser realizado un
circuito légico en un FPGA, con tal finalidad, como
muestra didactica se ha tomade come ejemplo la
realizacion de una puerta légica XOR dentro de la
FPGA, pudiéndose aplicar el mismo procedimiento para
circuitos muchos mas complejos. Se detalia ¢l proceso de
sintesis, implementacion, simulacién y la programacion
del FPGA, se utiliza el sistema de desarrollo "XUP
Virtex-II Pro" que contiene al circuito integrado
"XC2VP30" dentro del cual esta inserto un FPGA. El
ISE WebPACK 10.1, de distribucién gratuita, y
opcionalmente el simulador ModelSim XE son utilizados
como herramientas de software.

Abstract— The purpose of this paper is to learn the
methodology by which frem a file written in VHDL code
can be made a logic circuit in an FPGA, for this purpose,
as a sample didactical has been taken as an example the
realization of an XOR logic gate inside the FPGA, the
same procedure could be applied to many more complex
circuits. It details the process of synthesis,
implementation, simuiation and FPGA programming, it
uses the development system "XUP Virtex-11 Pro” which
contains the integrated circuit "XC2VP30" within which
is embedded an FPGA. The ISE WebPack 10.1, free
distribution, and optionally the simuiator ModelSim XE
are used as software tools.
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[. INTRODUCCION

A. El sistema de desarrollo XUP Virtex-11 Pro

El sistema de desarrollo XUP Vinex-II Pro se
muestra en la Fig. 1, en la parte central se encuentra ¢l
Circuito integrado (C.1.) XC2VP30 y en tomno a €l se
sifian los periféricos. EI C.I. XC2VP30 estd com-
puesto internamente por un (1) FPGA (del ingiés Field
Programmable Gate Array), dos (2) microprocesadores
Power-PC y ocho (8) transceptores Multi Gigabit. Las
caracteristicas del FPGA que esta insertado en el C.1.
XC2VP30 se muestran en la Tabla I.
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Fig. 1. Diagrama de bloques del sistema de desarrollo
XUPV2P.
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TABLAI
CARACTERISTICAS DEL FPGA INSERTO EN L1 C.1. XC2VP30

Slices 13565
Tamano de arreglo 80 x 46
RAMdistibuida 428 Kb
Bloques multiplicadores 136
Blogques de RAM 2448 Kb
Adminiswadores dereloj digital | §

B. Software para la programacion de FPGA

1. Xilinx WebPack ISE 10.1 -

Xilinx WebPack ISE (Integrated Software
Enviroment) es un programa de distribucion gratuita
que permite realizar fisicamente un diseno circuital
légico dentro de un FPGA. Se puede trabajar a partir
de un archivo escrito en VHDL (de VHSIC y HDL,
donde VHSIC es el acronimo de Very High Speed
Integrated Circuit y HDL es el acréonimo de
Hardware Description Language) que describe el
comportamiento del circuito, del disefio logico o de su
diagrama de estados. En este trabajo se detalla el
procedimiento que se sigue para programar al FPGA a
partir de un archivo escrito en VHDL. Brevemente, en
la Fig. 2 se describen las etapas que se sigue para la
programacion del FPGA. El programa Xilinx
WebPack ISE puede ser descargado de la pagina de la
referencia [1].
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Una vez que se ingresa al programa Xilinx mediante
su Interface Gréafico de Usuario (GU1) llamado Project
Navigator el usuario crea y da nombre al Proyecto. Los
archivos fuentes pueden ser creados y editados
mediante esquemas o  circuitos  1ogicos
combinacionales o diagramas de estados para el caso
de circuito secuenciales, en ambos casos ¢l programa
los traducira en un archivo que contenga el
funcionamiento de los circuitos en codigo VHDL.

También se tendra la alternativa que el usuario
pueda directamente agregar un archivo que contenga ¢l
codigo VHDL de cualquier circuito ldgico, como se
describe en el presente trabajo.

Posteriormente, luego del proceso de Sintesis se
pasara a la etapa de Simulacion, en donde mediante el
Simulador ISE o el Modelsim-SE se simulara el
funcionamiento del circuito. Luego se pasard al
proceso de implementacidn con el software incluido
PACE (Pinout and Area Constraints Editor) que
asignara las direcciones de los puertos de entrada y
salida a los pines del FPGA. Finalmente, se realizara
la programacion del FPGA, localizado en el sistema de
desarrollo de la placa VIRTEX Il Pro, mediante el
software incluido denominado iMPACT, con lo cual el
proceso concluye quedando el circuito légico realizado
en el FPGA.

™ Project Navigater DBy TGRS S
[P ,_"' Sut . A
- _ o L L L L N : ) d,:i"
= e Disefio s ‘
- A .
R 1 . . .
[ - !
1 - —W - / A A
: - . Ecquema Diagramad s vr\v' 7w
. : electronico de
, estados
: e swd A

I

Ii:] Lenguaje
Traduccion VHDL .
Simulacion  |jen— Sintesis

nen -
l LR

Implementacion

PR AR E D IALR IAILLATAN LS L))
[

R A LT T R T LTS LU T PR
FPrsheeor FIAF e 0

PACE

(LU

BN 1T AN LR AR BIAE TR CHETT MM T R
1 LSO~ U D s AT R .

Programacién
iMPACT

VIRTEX [| PRG

Fig. 2. Etapas para fa programacion del FPGA con el uso de XILINX WEB PACK 10.1.
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2. ModelSim XE y Simulador ISE

ModelSim XE (Xilinx Edition) es un simulador
HDL utilizado para simular disefios de Xilinx, esta
basado en la maquina de simulacién de ModelSim
PE de Mentor Graphics y requiere ser instalado, el
programa puede ‘ser descargado de la pagina de
Xilinx, ver tutorial de descarga de la referencia [2].
El simulador ISE en cambio esta inserto dentro de
Xilinx WebPack, en este trabajo se describira ambos
simuladores.

I[. METODOLOGIA

A. Creacion un nuevo Provecto
Abrir  Project Navigator, desde Inicio >

Programas > Xilinx ISE Design Suite 10.1 > ISE >

Project Navigator o haciendo doble clic en el icono
Xilinx ISE 10.1 del escritorio. En la barra de
herramientas, seleccionar File > New Project, asigne
un nombre y una carpeta de trabajo tal como se
indica en la Fig. 3. Presione Next para continuar.
Introducir en la ventana emergente la informacion
del dispositivo y de las herramientas a utilizar, tal
como se muestra en la Fig. 4. Los detalles del
dispositivo se encuentran el circuito integrado
ubicado al centro del sistema de desarrollo
XUPV2P, ver la Fig. 5. Presione Next para
continuar.

No se crearan ni agregaran archivos fuente
utilizando el asistente, por lo que debe hacer clic en
Next en las dos ventanas emergentes gue continuan.

Verificar la configuracion del proyecto en la
ventana emergente, 1al como se muestra en la Fig. 6.
Presione Finish para finalizar la creacion del
proyecto.
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Fig. 3. Creacidn de un nuevo proyecto.
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Fig. 5. Informacién impresa en el circuito integrado.
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Project Navigator will create a new project with the folowing specifications:

=

Projecc:
Project Name: Ejemplo
Project Patk: C:yXilinz\ProjectsiEjemplo
Top Lewvel Source Type: HDL

b

Device:
Device Family: Virtex2P
Device: ¥c2vp30
Package: ££88¢
Speed: -7

Synthesis Tool: XST (VHDL/Verilog)
Simulactor: HModelsim—SE VHDL
Preferred Language: VHDL

Enhanced Design Summary: enabled
Hessage Filtering: disabled
Display Incremental Nesseges: disabled

Existing Sources:

[ <.§ack_'|ljr anh J l -CanceI'H]

Fig. 6. Resumen de las especificaciones del proyecio.
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B. Asignacion del archivo fuente

Crear el archivo e¢jemplo_xor.vhd con la ayuda de
un procesador de texto que contenga el codigo que
se muestra en la Fig. 7, y guardarlo en la carpeta
principal del proyecto: C:\Xilinx\Projects\Ejemplo.

A_rl:hlvo gdmon Fgrmato ger Aygda

Tibrary Teee; T T
use TEEE.STD_LOGIC_1164.ALL;

ent'lty ejemplo_xor is
port € & @ in std_logic;
B : in std_logic;
¥ : out std_Tlogic );
end ejemplo_xor;

\architecture flujodedatos of ejemplo_xor s

begin
Y <= A XOr B;

end flujodedatos;

Fig. 7. Codigo VHDL dei archivo ejemplo_xor.vhd.

En la barra de herramientas, seleccionar Project >
Add Source y cargar el archivo ejemplo xor.vhd.
Presione OK en la pantalla emergente, ver Fig. 8.

The following allows you ta see the status of the source files b ject, and

allows you to specify the Design View assaciation far sources | b added to

the project.

: Design Unit ) ﬁ;ssuciation ! l 7‘
= ejemplo_sor.vhd I[ If I
@'eiemplo__xm flujodedatos |all v

L”",nqum

Fig. 8. Confirmacidn del archivo agregado.

Para observar el codigo VHDIL que ha sido
agregado hacer doble clic sobre el nombre del
archivo en la ventana Sources y €ste aparecerd en el
area de trabajo, como se muestra en la Fig. 9. Ahora
el area de trabajo funciona como un editor de texto.
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Fig. 9. Vista del codigo VHDL agregado.

C. Sintesis

En la ventana Processes, hacer doble clic en la
opcion Synthesize — XST. Si la sintesis fue exitosa,
en la ventana Processes apareceran un circulo verde
como se muestra en la Fig. 10, en caso contrario
aparecera un circulo rojo, en este caso leer la
ventana Transcript a fin de identificar y corregir el
error.

[Pocesses ______________________X]

Processes for; ejemplo_xor - flujodedatos
Add Existing Source
Create New Source
View Design Summary .
Design Utlities
User Constraints
L;)S ynthesize - XST
.@Vlew Synthesis Feport
[;] View RTL Schematic i
@ Wiew Technology Schematic l
£  Check Syntax .
* €2 Generate PostSynthesis Simulation Model
2 Implement Design
3 Generate Programming File
¢2 Configure Target Device
¥ Update Bitstream with Processar Data

1

“@@ﬁmﬂ

£ 4+

Co u

e e e = e
{
i

i @t Proceszes
Fig. 10. Finalizacion de la sintesis.

D. Simulacion mediante el simulador ISE

Crear una nueva fuente denominada
th_egjemplo_xor por medio del asistente, como se
indica a continuacion.
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En la barra de herramientas, seleccionar Project >
New Source. A continuacion seleccione la opcién
Test Bench Waveform vy escniba ¢l nombre de la
fuente; se aconsegja que el nombre del archivo tenga
el formato th_<nombre del archivo vhd>, donde tb
hace referencia a “test bench”. Ver Fig. 1 1.

Seleccionar el tipo de fuente al cual estd asociado
nuestro archivo fuente de simulacion, para este caso
sera ejemplo_xor. Ver Fig. 12.

Hacer click en Fimsh para salir del asistente.

Observar la ventana emergente que aparece,
ilamada Initial Timing and Clock Wizard de la Fig.
13, aplique sobre ella ios siguientes pasos:

* En el bleque Clock information, seleccionar la
opcidn Combinatorial (or internai clock).

¢ No seleccionar la opcion GSR (FPGA) del
bloque “Global Signals™.

e En el cuadro Initial Length of Test Bench
colocar ¢l tiempo estimado de simulacidén de
acuerdo a las escala de tiempo seleccionado.

Hacer click en Finish para salir del asistente de
configuracion.
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Fig. 11. Creacion de un archivo fuente Test Bench
Waveform.

Select & source with which Lo assaciate the new source. :

[ More Info ] I < Back H ) HEHIE ] I Cancel ‘

Fig. 12. Seleccion del archivo asociado al archivo fuente.
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Fig. 13. Configuracion para la escala de tiempos de la
simulacion.

Observar que aparece una nueva pestana de
nombre tb_ejemplo_xor.tbw en el area de irabajo,
en ella se asignara los valores de simulacion para las
sefiales de entrada del disefio, ver Fig. 14.

Las sefiales de simulacidn pueden ser
especificadas manualmente, en este caso, hacer un
click en las areas de color de la sefiales A y B para
cambiar su estado logico de tal manera de dibujar
progresivamente las sefiales de acuerdo a los
requerimientos del usuario.

En el caso que las sefiales de simulacién van a ser
especificadas automaticamente siga los siguientes
pasos:
¢ Hacer click derecho en el drea de asignacion de

la seiial A y seleccionar Set Value.

s Presionar el botdn Patlern Wizard, ver Fig. 15.
e Configurar la nueva ventana emergente llamada
Patter Wizard como se muestra en la Fig. 16.

Para el caso de la sefial B se debe repetir los
pasos anteriores, se debe configurar la pantalla
Pattern Wizzard como se muestra a continuacion:

e Pattern Type: Pulse
¢ Number Cycles: 5
e Initial Value: 0

e Pulse Value: |

¢ Initial Delay: 2

s Pulse Width: 2
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Fig. 14. Parte de la ventana Test Bench Waveform en el
area de trabajo.
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Fig. 15. Ventana Asignacion de valor de seiial.
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Fig. 16. Ventana Asistente de Asignacion de valores de
seiial,

Para extender la escala de tiempo de la pestaia
Test Bench de la Fig. 13 (que se mostrd), hacer
ciick derecho sobre una zona libre del area de
trabajo, seleccionar la opcién Set End of Test
Bench y asignar un valor de tiempo final de 2000
ns, como se muestra en la Fig. 17.

Fig. i7. Asignacion del tiempo final de la ventana Test
Bench.

Guardar el archivo y observar que en la ventana
de trabajo aparecen las sefiales con los valores y la
escala establecida. Ver Fig. 18.

End Time: // . .
nae a0 A ns iTelns 20[0ns
2000 ns Lot bl
m 1 o
ane 1 1 \
Uy 0 \
6043
I( Y& 3
[ to_eiemplo_vortbw |

Fig. 18, Senales de simulacion con los valores
establecidos.

En la ventana Sources, seleccionar la opcion
Behavioral Simulation de la lista despiegable, luego
scleccionar  xc2vp30-7ff896 > b _ejemplo_xor
(tb_ejemplo_xor.tbw), tal como se muestra en la
Fig. 19.

1

. Sources for: . Behavioral Simulation v

| ':1 Ejemplo
C g5 no2vpd0-TH8Is
+ Lnth_ejemplo_sor (tb_eiemplo_xor.thw)

4

%

B3 Source [y Files | Snaps?{@ Librari(lf Sim Insteli

Fig. 19. Seleccion del archivo fuente a simular.

En la ventana Processes, seleccionar la pestafa
del mismeo nombre, en ella desplegar la opcién
Xilinx ISE Simulator y hacer doble click en
Simulate Behavioral Model, ver Fig. 20.
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’-Plocesses for: th_ejemplo_sxor
Add Existing Source
Create New Source
View Generated Test Bench As HOL
Add Test Bench To Project

il 1SE Simulator
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Fig. 20. Inicio de la Simulacién.

Observar que aparecera una nueva ventana con
los resultados de la simulacién, ver Fig. 21. Para
extender el tiempo de simulaci6n, como por ejemplo
a 1000 ns, seleccione en la barra de herramientas la
opcién Run for Specified Time ** , ver Fig. 22.

pns 25T ns 1500 ns 1750 az 2000 ng

Current Sienutation

Time: 2000 ns e Ll Ll
Y 0 / L— =
‘an'\ 0 —_ FL._— —

LR ] \

< H D

i

¥
[ b_cenph sortow [ Sivaim \\

Fig. 21. Resultados de la simulacion.

b [0 vlns vl

=Run Far Specified Time

Fig. 22. Especificacion de tiempo de simulacion.

E. Simulacion mediante ModelSim XE

1. En la ventana Sources, seleccionar la opcion
Behavioral Simulation de la lista desplegable,
luego seleccionar xc2vp30-7{T896 >
ejemplo_xor — flujodedatos (ejemplo_xor.vhd),
tal como se muestra en la Fig. 23.

2. En la ventana Processes, seleccionar ModelSim
Simulator > Simulate Behavioral Mode, tal como
se muestra en la Fig. 24, Hacer doble clic para
abrir ModelSim.
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Sauces for Behavioral Simulation v
) _733 Ejempla
= 4 uc2vp30-7if896
' ejemplo_xor - flujodedatos (ejemplo_xor.vhd)

B Sources [ Files i gg Snapshats [ Libraries

—— T

Fig. 23. Seleccion del archivo fuente a simular.

Pracesses for, ejemplo_xor - flujodedatos
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I Create Mew Source
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M  Simulate Behavioral Model

2{ Piocesses ]

!

Fig. 24. Seleccion de ModelSim como simulador.

3. En ModelSim, hacer clic en ¢ boton Unlock de 1a
ventana Wave, ver Fig. 25, a fin de permitir que
se visualicen con mayores detalles las sefiales de
prueba que se ingresaran. Luego, maximizar la
ventana Wave,

4, En la barra de herramientas de simuiacion, haga
clic en el boton Restart, luego establezca el
tiempo de simulacién escribiendo 1000 ns en el
cuadro de texto, ver la Fig. 26.

P wave - defauk - 431X
Unlock 1

Fig. 25. Desbloqueando la ventana Wave.

R.esturt—l
= | 1000 ns::jif?ﬁ[

Fig. 26. Barra de herramientas de simulacion.

r Run

5. En la ventana Wave de ModelSim, seleccionar la
sefial /ejemplo_xor/a, luego haga clic derecho y
seleccione Clock, como se indica en la Fig. 27.

6. En la ventana emergente, ingrese el periodo de la
senal de reloj, para este caso 200 ns, como se
muestra en la Fig. 28. Luego haga clic en OK.
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7. Repita los pasos 3 y 4 .para la seiial
/ejemplo_xor/b, asigne periodo de 100 ns.

cee - - [ —— J— -

8. En la barra de herramientas de simulacion, haga - Clock Name ,
clic en el botdon Run, ver Fig. 26. El contenido de "|sim: sejemplo_xor/a i
la ventana Wave se actualizara, para observar los e e T !
resultados de la simulacidn con mas detalle haga - offset~ = == -~ - Duty~ -~
clic en el boton Zoom Full de la barra de f

} . i lﬁ)
herramientas Zoom, ver la Fig. 29. _* A L

9. Hacer clic sobre la linea de tiempo y arrastrar ¢l
mouse para poder observar los valores de las
sefales de entrada y la respuesta del diseno jJZUDUUU [

~Period - - - . Cancel -

!
H
!
g — . . - s e = . [R—

légico, tal como se muestra en la Fig. 30.
Logic Yalues
‘- | kP High:il Low:lU
Fle Edt ¥iew add Famsat Took Vredow T T
o e e —m - First Edge
= Sh i By o ' -
J& & = . ™ Rising *~ Faling .
OK I Cancel i

Fig. 28. Caracteristicas del reloj.

aaeq
Cut Crith- T
Copy cetic Zoom Full
Faste Cril-y
Defete Fig. 29. Barra de herramientas de Zoom.
Croup...

{rsett Divider

[risest Greabooint

Force. ..

Fig. 27. Asignacion de una sefal de reloj a la sefial A. Fig. 30. Resultados de la simulacion.
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F. Implementacion

En Project Navigator, seleccionar la opcidn
Implementation de la lista de opciones en la ventana
Sources, como lo indica la Fig. 31.

Sources

Sources for

‘jElem mplementation.
S £wcv Behavioral Simulation

ma Post-Translate Simutation
"1 Post-Map Simulation

F‘ost-Fﬁuule Simulation

E7g Sources ‘U F|les

—

OJSnapshnts - [@L[branes i

Fig. 3i. Regresando de Ia simwlacion a la
implementacion.

Hacer doble clic sobre la opcion Implement
Design de la ventana Processes. En la ventana
Transcript apareceran mensajes relativos al proceso
de impiementacion de disefio, una vez terminada la
implementacion apareceran los circulos verdes
mostrados en la Fig. 32.

Processes

Pracesses for: ejemplo_xor - flujodedatos
1 AddEuzisting Source
™ Cicate New Source
= View Design Summany

Design Utilities

3&‘ User Constraints

&2 Synthesize - XST

C}.Implement Design

* f}OTranslake

- QX DOMan
# #)Place & Route

+ 83  Gererate Programming File
£ P2 Configure Target Device
¥ Update Bitstream with Processor Data

H M

i

i

!

!{" Processes i

Fig. 32. Resultados del proceso de implementacién.

Hacer doble clic sobre la opcién Floorplan Area /
10 / Logic — Post-Synthesis, dentro de la seccion
User Censtraints en la ventana Processes, tal como
lo muestra Ia Fig. 33. Este paso es obligatorio para
posteriormente asignar a los pines del CI XC2VP30
las entradas y salidas del circuito (puertos).

Processes for; ejemplo_xof - flujodedatos

[ AddEmnsting Source
3 Create Mew Source
£ View Design Summary
T W Design Utiities
25 User Conztraints
: ﬁ Create Timing Constraints
: Floorplan 10 - Pre-Syrthesis
Floorplan Area /10 / Logic - Post-Synthesis
CQ!@ Synthesize - XST
232 Implement Design

¥  Generate Programming File

T E®

3‘__‘\

Ea]

3 #J  Configwe Target Device
?j Update Bitstream with Processor Data

@{: Processes i

— i

Fig. 33. Inicio del proceso de declaracidn de terminales.

Hacer clic sobre el boton OK en la ventana
emergente y luego aparecera la ventana principal de
la herramienta Xilinx PACE (Pinout and Area
Constraints Editor), ver la Fig. 34. Si en caso no
pudiera ver alguna de las ventanas, puede activarlas
desde el menil View.

Sl PACE P e eSmplo o, k- e
FEle Edt View [OB: Avess Took L\l_’ndou Help
DER G v M LN .

Fig. 34. Ventana principal de la herramienta Xilinx
PACE.

En el campo Loc de la ventana Design Object
List — /O Pins, introducir los nombres de los pines
que se utilizaran para cada puerto del proyecto. En
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este caso se asignara el pin ACI1, que corresponde
a SWO para el puerto A, AD11, que corresponde a
SW1 para el puerto B y AC4, que corresponde al
LEDO para el puerto Y, como se muestra en ia Fig.
35, Para mayor informacion de la localizacion de los
conmutadores y LEDs revisar el manual de
referencia de hardware [3]

Cerrar Xilinx PACE y guardar los cambios, luego
en Project Navigator volver a realizar los pasos 2 y
3, y comprobar que los pines asignados no han sido
alterados. Si no hay error cerrar Xilinx PACE, caso
contrario repetir los pasos anteriores.

| _]1![] Namellll] Directinn1 Loc |Bankt
i 'fb, o Input ) lﬁ.Cl‘l ~ BANK
(e lput ADTY - BANK
(MY  Oupat ~ ACA  BANK
14 »

Fig. 35. Asignacion de pines del dispositivo.

G. Programacion del dispositivo

Conectar el sistema de desarrollo XUPV2P y
encenderlo. Luego de que la computadora lo
reconozca, hacer doble clic sobre la opcidn
Configure Target Device de la ventana Sources.
Configure las opciones de la ventana emergente,
correspondiente a la herramienta IMPACT, como se
muestra en la Fig. 36.

Hacer clic en el botén Bypass de las dos primeras
ventanas emergentes denominadas Assign New
Configuration File, ver Fig. 37(a), porque estas
ventanas corresponden a la PROM y a SystemACE
del sistema de desarrollo. En la tercera ventana, que
corresponde al XC2VP30, seleccionar
ejemplo_xor.bit y hacer clic en Open, ver Fig.
37(b).

| Please select an action frem the fist below

(* Corfigure devices using Baundary-Scan (TAG)

I Mﬁi&béﬂ;@ggl toa catrle g_n_d Bmﬂly?wﬂatgﬁ%;h_am v,
Frapsve s PRDM B2
Fropre = Sutem ACE Fls

{5 Prepaie a Boundary-Scan Fie

s Configuie devices

E‘i?E Elrwh “i. i Cancel J

Fig. 36. Configuracion de iMPACT.
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() Enabie Programming of BPY Flash Device Altached to this FPGA
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Fig. 37. Asignacion de archivo de configuracion.

Hacer clic en OK en las dos ventanas emergentes,
luego seleccionar el dispositivo XC2VP30, hacer
clic derecho y seleccionar Ja opcion Program, tal
como se indica en la Fig. 38.

Hacer clic en el boton OK en la ventana
emergente y se iniciara la programacién del sistema
de desarrollo XUPV2P. Aparecerd el mensaje
Program Succeceded si el proceso fue exitoso, como
se muestra en la Fig. 39.

XIURY LIS CAXIBmR o)y
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Set Progy e Properbes. ..
Set Erasn Propertes. ..
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Fig. 38. Programaci6n del dispositive XC2ZVFP30.
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PAREME 4 RSO FN

Ll s = y
i e e 5

xet32p xceace xc2vp30
bypass bypass eierhplo_xor il
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Fig. 39. Programacion exitosa del sistema de desarrollo
XUPV2P,

I11. RESULTADOS

Luego de la programacion exitosa del dispositivo,
podemos verificar su funcionamiento, recordemos
que se ha realizado una puerta i6gica XOR en el
FPGA, tal como inictalmente se describio en
lenguaje VHDL, ver Figura 7, la puerta posee dos
puertos de entradas (A, B) y uno de saiida (Y).

En las fotografias de la Figura 40, los
conmutadores SW0 vy SWI  representian
respectivamente a los puertos A y B de la XOR,
mientras que el LEDO representa al puerto Y (tal
como fue especificado en el paso F de Ia
Metodologia).

USER INPUT

’l

i
=
o
%
—
m
[
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(b)

'lxﬁi'i"u;' 09
y =

*

(d)

Fig. 40. Resultados experimentales.

Para verificar el correcto funcionamiento de la
puerta logica, hay que tener en cuenta que el LEDO
estd polarizado inversamente, por este motivo
cuando la salida es 0 logico el LEDO se ilumina,
mientas que cuando es 1 logico el LEDO se apaga.
La Tabla Il explica los resultados mostrados en las
fotografias de la Figuras: 40(a), 40(b), 40(¢) y 40(d).
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TABLA I
RESULTADOS
Figura SWI SWIQ) LEDO
40 (a) ON ON Encendido
(1 logico) | (1 16gico) {0 16gico)
40 (b) ON OFF Apagado
' (1 logico) | (0 logico) {1 logico)
40 (c} OFF ON Apagado
(0 logico) | (1 logico) (1 légico)
40 (d) OFF OFF Encendido
{0 logico) | (0 logico) {0 1gico)

Verificandose el correcto funcionamiento de la
realizacion en el FPGA de la puerta logica XOR.

V. CONCLUSIONES

Se ha realizado un circuito légico dentro de un
FPGA teniendo la descripetén del circuito 10gico en
codigo VHDL, se ha pasado por todas las etapas del
disefio, tales como: sintetizar, simular, implementar
y programar el CI XC2VP30 del sistema de
desarrollo XUPV2P utilizando el programa Xilinx
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WebPack ISE. La simulacion ha sido lograda
mediante dos herramientas: el simulador de ISE y ¢l
ModelSim XE.

Se ha descrito un proceso para un FPGA inserto
en el sistema de desarrollo XUP Virtex-1I Pro, sin
embargo, los pasos descritos se ajustan para
programar a cualquier otro FPGA ¢ inclusive a
CPLDs.
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